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ABOUT AVEON 

Aveon InfoTech Pvt.Ltd,an ISO 9001:2008 certified Company offers world class information 

technology solutions including software development, maintenance services, and consultancy services, products 

across various platforms, applications and verticals. Aveon provides these cost effective outsourced services for 

companies in Europe, United States. 

 

ABOUT CMS 

In today’s world, administration & management of organizations, particularly, educational institutions, 

has become a tedious and complex task. It requires careful planning, systematic approach and accurate control 

of administrative processes to attract the best students, produce best results and project the best image. Coupled 

with tight competition from the industry, these institutions are increasingly seeking the help of information 

technology to improvise their facilities and maintain a competitive edge to their educational business. We are 

providing world class, extremely efficient, systematic and sophisticated user friendly automated worldwide 

copyrighted web based, server based and cloud based  product campus called ‘College Management System’ its 

responsible for android/ iphone / windows mobile devices 

 

Aveon InfoTech has humongous list of advantages for Management, Parents, Employees and Students 

with respective login rights. 

 

BENEFITS TO MANAGEMENT 

 Effective communication between teachers, parents and students.  

 Complete automation of all operations.  

 Reliable and secure software. 

 Cost-effective one point solution for total campus management.  

 Zero redundancy in managing the institution’s records. 

 Save lots of investment in different software and management issues. 

 Able to Access, Control and view your institutional activities Like Admission Details, Students information,  

Staff Details, Fees collection details, Academic progress, Inventory Status, Supplier’s outstanding details, 

Transportation details, Payroll details, Accounts, Exams and Results details, from anywhere in the world 

through PC/ Mobile/ Tablet. 

 

BENEFITS TO ADMINISTRATION 

 Get Easy Online Enquiry for Admission. 

 Simple admission process. 

 Reduce Manual / Paper works and time Consumptions.  

 Automated and quick report generation along with process turnaround time. 

 Centralized data repository for trouble-free data access. 

 Easy performance monitoring of individual modules leading to uncomplicated error detection. 

 User friendly interface requiring minimal learning and IT skills. 

 High level data security 

 Minimal data redundancy. 

 Dashboard for individual Login 
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BENEFITS TO PARENTS 

 Get connected to the school/College effectively and easily. 

 Frequent interaction with teachers. 

 Active participation in campus activities. 

 Reliable update on children / Students attendance, progress report and fee payment. 

 Prior information about school/College events and holidays. 

BENEFITS TO STAFF 

 Automated student attendance. 

 Computerized management of marks and grades. 

 Timetable creation in advance. 

 Availability of more time for students. 

 Efficient and effective interaction with parents. 

 Access to a forum common to students and parents. 

 Access to own and student’s attendance. 

 Better participation in campus activities. 

 Manage class information and analytical reports. 

 SMS, E-mail & Internal messaging system. 

BENEFITS TO STUDENT 

 Enhanced interaction with teachers, parents and peers. 

 Access to circulars, events, attendance, timetable, marks, grades and examination schedule& placement 

activities. 

 Liberty to publish articles and views, and participate in discussion forums. 

 Freedom to browse through library books catalogue and identify the book(s) to be issued. 

 Prior information about campus events and holidays 

OUR SERVICE 

AVEON’s area of specialization is in application software development for Education, Health Care, 

Insurance, and Web Application. We undertake software development for both domestic and international 

customers. We have vast experience in design and development of large integrated commercial applications 

customized to user needs. 

We also offer our international clients the following services 

 ERP Development  

 Product Development  

 Architecture Consulting 

 Database Design 

 API Gateway solution 

 Staff Augmentation   

 Identity and Access Management 

 Business Process Management 
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 Web development and Hosting 

 E-commerce 

 B2B Websites 

 B2C Websites 

 Live streaming  

 Bulk SMS and Email 

 Data warehousing 

MODULES AND FEATURES  

ADMISSION 

 New candidate Enquiry details. 

 Online & Offline Enquiry 

 Admission reservation 

 Candidate Course Preference 

 Candidate to student Conversation. 

 Upload Bulk Student details. 

 Student Direct Admission. 

 Student Entry. 

 Student Extra Details. 

 Students Individual Login ID, Password. 

 Automatic Roll No & Register No Generation. 

 Student Certificate Tracking Details & Issue. 

 Student disciplinary actions details. 

 Student Extra Curricular Activity details. 

 Student Scholarship Information. 

 Student Alumni Information export.  

 Online Admission Application. 

 Student ID Card Printing 

 Bulk Student Information export 

 View Student Complete details 

 Student Strength Details 

 Admission query Builder report 

 Admission summary by country, state, city, gender, admission category, community, caste, religion, 

department, program, batch, class 

 Easy Student details export in Excel/Word/PDF Format. 
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ACADEMIC 

 Add Curriculum 

 Course Management   

 (Subject, Regulation subject, Syllabus, Time table, 

  Staff Allocation, Lesson Plan configuration) 

 Course Approval concept 

 Import Bulk Course and Syllabus 

 Various Types of Course type support (JOC/MACE/PACE/IDC/etc.,) 

 Integrated subject  

 Quick and Easy Time Table creation 

 Automatic Class Timetable generation. 

 Student Day/Session/Period wise Attendance posting. 

 Choose Elective Paper for Student. 

 Student Attendance with Topic covered. 

 Student’s attendance through Bio Metric device. 

 Outcome Based Education (OBE) 

 Open Elective 

 CBCS (Choice Based credit System) 

 Special Class / Staff Back  

 Attendance boost up 

 Students leave Apply. 

 Education Trip (Industrial Visit). 

 Class Observation 

 Staff Work Board 

 Error Analysis 

 Home Work  

 Monthly academic Planner 

 Multiple working Hour for Staff & Students 

 Automatic Staff Replacement. 

 Academic Calendar 

 Student Performance  

 Conduct Events (Symposium, Annual Day, Sports Day, etc., ) 

 Project /IV/ IPT Review Reports. 

 Pedagogical Report (Log Book) 
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LIBRARY 

 Create Catalog 

(Catalog details/Accession details/Author details/Book quantity /Supplier details/Catalogue type/Number 

pattern/Automatic accession no generate) 

 Library rules configuration. 

 Patron & Patron rule configuration  

 Circulation Rule configuration  

 OPAC Search. 

 Books details Entry. 

 Bulk Catalog Import. 

 Book Check in, Check out and reserve details. 

 Fine Calculation (Late submit, Breakage, etc.,) 

 Stock Verification. 

 Journals Subscription Alert and Date wise reports. 

 Transfer Book one to another library. 

 Student/Staff Gate register. 

 Library usage tracking 

 Most used and not used catalog  

 Book Reservation 

 New books arrival details  

 Library due Clearance  

 Periodicals & Non Book Materials. 

 Serial subscription 

HR 

 Online / Offline Staff Recruitment  

 Job opening posting in College website 

 Applicant selection and interview call letter send 

 Interview configuration  

 Offer letter issue 

 Manual staff entry  

 Bulk staff Import 

 Staff Certificate tracker 

 Staff completed details 

 Staff Extra Curricular Activities  

 Staff appraisal  

 Staff complete profile  

 Staff Strategic Planner  

 Staff work board 

 Task Management 
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PAYROLL 

 Staff Leave and Permission configuration 

 Online Employee Permission request 

 Online Permission Approval/Cancel 

 Online Staff Leave Request 

 Online Staff Leave Approval/Cancel 

 Over Time Apply & Approval 

 Alternate Staff Approval 

 Employee Attendance through Bio Metric device. 

 Employee Manual Attendance. 

 Employee Monthly Attendance. 

 Salary Calculation based on Leave, LOP, Permission and PF, ESI, HRA, Basic 

 Staff Advance Payment, Return& Cancel. 

 Online/Offline Salary Payment. 

 Online Salary Payment Cancel. 

 Salary Slip & Statement. 

 Salary Increment based on Performance report. 

 

FEES COLLECTION 

 Online Payment Gateway Integration. 

 Online Fees Payment. (Tuition Fees, Exam Fees, Hostel, Transportation, Etc.,) 

 Students Advance Fees Collections. 

 Student Fee fine Calculation 

 Candidate Advance Fee Collection and Return. 

 Additional Allot/Fees Collection (Breakage, Fine, Books) 

 Generate Bulk Receipts. 

 Bus Fee Configure.(Route wise, KM wise) 

 Hostel Fee Configure.(Year wise) 

 Mess Fee Collection. 

 Upload Bulk Fee details. 

 Import Fee Receipt. 

 Edit/Modify Fee details. 

 Generate Student Advance Online Receipt. 

 Generate Additional Fee Receipt from Online. 

 Generate Individual Student Fee Receipt. 

 

FEEDBACK 

 Feedback Q&A. 

http://192.168.1.60/cms/HelpVideos/Videos/payroll_transaction_EmployeeAttendance.pdf
http://192.168.1.60/cms/HelpVideos/Videos/payroll_transaction_Employee_Manual_Attendance.pdf
http://192.168.1.60/cms/HelpVideos/Videos/payroll_transaction_Employee_Monthly_Attendance.pdf
http://192.168.1.60/cms/HelpVideos/Videos/payroll_transaction_Staff_Advance_Pay.pdf
http://192.168.1.60/cms/HelpVideos/UserManual.htm
http://192.168.1.60/cms/HelpVideos/Videos/Feedback_Configuration_Feedback_QuestionAnswer.pdf
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 Feedback Construction. 

 Feedback Setup Institution Wise. 

 Feedback Setup Department Wise. 

 Feedback Setup Batch-Academic Year Wise. 

 Feedback Setup Semester Subject Wise. 

 Feedback Setup Staff Placement Training Wise. 

 

PLACEMENT 

 Create/ Maintain Employer Details. 

 Conduct Campus Interview. 

 Create Eligibility criteria for Interview Qualification. 

 Student Position. 

 

SMS 

 Group SMS. 

 SMS Summary Report. 

 SMS Details Report. 

 SMS Institution Wise. 

 SMS Staff Type Wise. 

 SMS Gender Wise. 

 SMS Department Wise. 

 SMS Batch Wise. 

 SMS Course and Program Wise. 

 SMS to Parents about their ward Attendance status. 

 

OFFICE MANAGEMENT 

 Student Certification Tracking 

 All Type Bonafied certificates  

 TC, Corse Competition Certificate Printing. 

 Student Performa Report Generation  

 Student Complete Profile 

 Student disciplinary action   

 NAAC reports. 

 Student No Due 

 

LMS (Learning Management System) 

 Online Assignment 

 Online Feedback 

 Online Exam  

http://192.168.1.60/cms/HelpVideos/Videos/Feedback_Configuration_Feedback_Construction.pdf
http://192.168.1.60/cms/HelpVideos/UserManual.htm
http://192.168.1.60/cms/HelpVideos/UserManual.htm
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 Study Material Download 

 Polling & Survey 

 Tutor ward 

 Club Activity 

 Event Management 

NAAC 

 NAAC Activity by staff 

 NAAC Activities by Department 

 NAAC Activities by student 

 

DASHBOARD 

 Circular & News Events 

 Birthday & Wedding day wishes 

 Staff calendar  

 Pending jobs 

 Staff Payroll dashboard 

 Admission Dashboard 

 Fees Collection Dashboard 

 Staff and Student count dashboard 

 Staff and student attendance dashboard 
 

REPORTS 

 More than 500 Defined Reports for Engineering. 

 More than 400 defined reports for Arts & Science. 

 Support Customized Reports. 

 

http://192.168.1.60/cms/HelpVideos/UserManual.htm
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S.No Menu 
Page 
No 

1 Department Creation   

  Department Creation 18 

  Exiting Department list Find 18 

2 Programme Creation   

  Existing Department list find 19 

  Existing Department list find 19 

  Working hour adding for program 19 

3 Academic Year Creation    

  Find out Existing academic year details 20 

  To create New Academic Year  21 

4 Academic Year semester Creation    

  Find out Existing academic year semester details 21 

  To create a new Academic Year selection   22 

5 Regulation Creation    

  Find out Existing Regulation details 23 

  Add Regulation details 23 

6 Batch Creation  13 

  Find out Existing Batch Details 24 

  Edit Batch Details for Add class , Assign Tutor, add working hour, student class allocation  24 

  Add Batch Details 26 

7 Room Creation    

  Find out Existing Room Details 27 

  Add Room details 27 

  Edit Room details 28 

8 Student Staff Grievance    

  Grievance Type configuration  29 

  Add Grievance 30 

  Update Grievance status 30 

9 Seminar Hall Booking    

  Hall Booking 31 

  Hall Booking Approval 31 

10 Holiday Creation    

  Holiday Creation  32 

11 Student staff Thoughts     

  Student Staff Thought Creation  34 
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12 Staff Management     

  Existing Staff details & edit Staff Information 34 

  Add New Staff Details 37 

13 Staff Complete Profile   38 

14 Staff  Leave Apply   

  Staff Leave Apply  41 

15 Staff  Leave Approval   

  Staff Leave Approval  42 

16 Staff  Permission Apply   

  Staff Permission Apply  43 

17 Staff  Permission Approval   

  Staff Permission Approval  43 

18 Candidate Enquiry    

  Enquiry Adding 44 

  Candidate follow up 46 

  Candidate to Student Conversation  47 

19 Student Management    

  Student details modification  48 

  Student Disciplinary Actions 50 

  Student Certificate request configuration  51 

  Student complete details  52 

  Student late Register 55 

20 Subject Details adding   

  Import Subject Entry 57 

  Import Syllabus Entry 57 

  Import Regulation Entry 57 

  Single Subject Entry 58 

  Subject Approval sending to COE Approval 59 

  Subject Adding from Tutor login 60 

  Open Elective Subject Creation 60 

  Choice based Credit system Creation 62 

  Open elective subject selection form Student login    63 

  Choice based Credit system subject selection from student login 63 

21 Time table Creation    

  Time table Creation 63 

22 Subject card / LMS   

  Subject card 66 

  LMS Menu 66 

  Lesson plan creation  67 

  material upload  67 
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  lesson plan approval 69 

  Student attendance Search   69 

  student Attendance Posting 70 

  student Attendance cancel 71 

  Assignment Creation   71 

  Stay back and Special Class  Creation   72 

  Internal Creation  73 

23 Staff Change   

  Class wise /Staff wise /Exam – Class Arrangement 73 

24 Student Leave Apply  75 

25 Circular    

  Create a circular  76 

  Circular list & upload the files for the circular 76 

26 Event   

  Event Creation 77 

  Class Arrangement 78 

27 Tutor Ward System   

  Add  Tutor 80 

  Add Ward 80 

  Change Tutor or Ward 80 

28 OBE (Out Come based Education ) 82 

29 Polling 83 

  Student Login 85 

30 Complaint Register 85 

  Profile Edit  85 

  Poll Voting 85 

  View Circular 85 

  Assignment upload  86 

  View Event 86 

  View Exam timetable 86 

  Leave apply  86 

  Hostel Request application 87 

  Library book taken history 87 

  Feedback providing 87 

  Fees Details view  88 

  Attend online exam 88 

31 Dashboard 89 
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1. Department Creation 

 

a. Department Creation 

 

Navigation 

 

Administration -> Institution -> Select intuition from which you need to create department ->click department 

bottom of that intuition -> click + Add New for Create new Department -> provide the data and click save 

 
 

b. Existing  Department list find 

Navigation 

Administration -> Institution -> Select intuition from which you need to create department ->click department 

bottom of that intuition -> you will find out the department list Existing  

 

 

 

2. Programme Creation 
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a. Existing  Department list find 

Navigation 

Administration -> Institution -> Select intuition from which you need to create department ->click department 

bottom of that intuition -> you will find out the department list Existing  -> Click the Programs -> You will find 

the Existing  degree program list. 

 

b. Existing  Department list find 

 

Navigation 

 

Administration -> Institution -> Select intuition from which you need to create department ->click department 

bottom of that intuition -> you will find out the department list Existing  -> Click the Programs -> click +Add 

new -> Provide the degree Program details -> click save. 

 

c. Working hour adding for program 

 

Navigation 

 

Administration -> Institution -> Select intuition from which you need to create department ->click department 

bottom of that intuition -> you will find out the department list Existing  -> Click the Programs -> click working 

Hours -> Choose the necessary field and click save  
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3. Academic Year Creation  

 

a. Find out Existing  academic year details 

 

Navigation 

 

Master -> Academic Year -> find the institution -> you will find the academic year details which is Existing   

 

 

 

b. To create New Academic Year  
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Navigation 

 

Master -> Academic Year -> find the institution -> you will find the academic year details which is Existing  -> 

click + button -> provide the academic year details and click save changes -> Generate student day attendance 

after time table configuration done. 

 

 

 

4. Academic Year semester Creation  

 

a. Find out Existing  academic year semester details 

 

Navigation 

 

Master -> Academic Year -> find the institution -> you will find the academic year semester details which is 

Existing   
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b. To create a new Academic Year selection   

 

Navigation 

 

Master -> Academic Year -> find the institution -> you will find the academic year details which is Existing  -> 

click + button -> provide the academic year details and click save changes -> Generate student day attendance 

after time table configuration done. 
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5. Regulation Creation  

 

a. Find out Existing  Regulation details 

 

Navigation 

 

Master -> Regulation -> you will find the Regulation details which is Existing   

 

b. Find out Existing  Regulation details 

 

Navigation 

 

Master -> Regulation -> you will find the Regulation details which is Existing  -> click add Regulation  
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6. Batch Creation  

 

a. Find out Existing  Batch Details 

 

Navigation 

 

Master -> Batch -> Select institution -> Select Program -> you will find the batch details Existing  for selected 

program 

 

 

 

b. Edit Batch Details for Add class , Assign Tutor, add working hour, student class allocation  

 

Navigation 

 

Master -> Batch -> Select institution -> Select Program -> you will find the batch details Existing  for selected 

program -> Action -> Edit -> Modify the information Add class, Assign Tutor, add working hour, student class 

allocation -> save semester => update  
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c. Add Batch Details 

 

Navigation 

 

Master -> Batch -> Select institution -> Select Program -> Click + Add New -> Provide the details and click save 
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7. Room Creation  

 

a. Find out Existing  Room Details 

 

Navigation 

 

Master -> Room -> you will find the room details Existing  

 

 
b. Add Room details 

 

Navigation 

 

Master -> Room -> click + Add New  

 
c. Edit Room details 
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Navigation 

 

Master -> Room -> you will find the room details Existing  -> Click edit -> Modify the details -> save 
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8. Student Staff Grievance  

 

a. Grievance Type configuration  

 

Navigation 

 

Master -> Grievance Types -> you will find the Grievance type Existing  -> Click + Add New -> Provide the 

details -> save 

 

b. Grievance Type Modification  

 

Navigation 

 

Master -> Grievance Types -> you will find the Grievance type Existing  -> Click edit -> modify the details -> 

save 
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c. Add Grievance  

 

Navigation 

 

Master -> manage Complaints -> You will find the complaint details Existing  with complaint status -> if you 

wants to add a new complaint click + Add new  

 

 
d. Update Grievance status 

 

Navigation 

 

Master -> Complaint status -> You will find the complaint details Existing  with complaint status -> provide the 

details search -> update the status   
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9. Seminar Hall Booking  

 

a. Hall Booking 

 

Navigation 

 

Academic -> Seminar hall booking -> select the date -> Provide the information -> saves 
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b. Hall Booking Approval 

 

Navigation 

 

Academic -> Seminar hall booking Approval -> select the date ->search -> click approve or reject ->saves 

 

 

10. Holiday Creation  

 

a. Holiday Creation  

 

Navigation 

 

Mater -> Holiday -> select Institution -> Click on holiday name -> provide the holiday details ->saves 
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11. Student staff Thoughts   

 

a. Student Staff Thought Creation  

 

Navigation 

 

Mater -> Student Staff Thought ->select Institution -> Click + Add new -> provide your details ->saves 
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12. Staff Management   

 

a. Existing  Staff details & edit Staff Information  

 

Navigation 

 

Human Resource -> Staff Management ->select Institution -> Select Department -> you will find the staff details 

Existing  in select department 
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b. Add New Staff Details  

 

Navigation 

 

Human Resource -> Staff Management ->select Institution -> Select Department ->          -> Provide the staff 

information -> Click save 
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13. Staff Complete Profile   

 

 

Navigation 

 

Silver light Payroll -> Transaction -> Select Institution -> Select Department -> select Staff -> you will find the 

staff General Information, Academic Details like timetable, subject handling details, Syllabus, results, attendance 

in/out details, daily attendance details, Leave & Permission details , Salary details, Certificate details etc.,  
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Aveon Infotech Pvt Ltd 
 

3
9
 

 

 

14. Staff  Leave Apply 

 

a. Staff Leave Apply  

 

Navigation 

 

Payroll -> Staff Leave apply ->Select Current payroll Year -> click Apply new Leave-> select leave type -> 

provide date-> Make alteration -> apply 
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15. Staff  Leave Approval 

 

a. Staff Leave Approval  

 

Navigation 

 

Payroll -> Staff Leave Approval -> you will find out the list of applied leave by staff -> select the staff leave -> 

click Approve 
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16. Staff  Permission Apply 

 

a. Staff Permission Apply  

 

Navigation 

 

Payroll -> Staff Leave apply -> click New-> provide date-> Select Permission type -> Make alteration -> apply 

 

 

 

17. Staff  Permission Approval 

 

a. Staff Permission Approval  

 

Navigation 

 

Payroll -> Staff Permission Approval -> you will find out the list of applied permission by staff -> select the staff 

permission -> click Approve 
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18. Candidate Enquiry  

 

a. Enquiry Adding 

 

Navigation 

 

Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -> add -> Provide the 

candidate information -> Save 
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b. Candidate follow up 

 

Navigation 

 

Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -> Edit the candidate 

list -> click follow ups -> provide the details -> save 

 

c. Candidate Payment  

 

Navigation 

 

Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -> Edit the candidate 

list-> click Add payment -> provide the details -> save 
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d. Candidate to Student Conversation  

 

Navigation 

 

Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -> in action convert 

student -> select the details -> convert the student 
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19. Student Management  

 

a. Student details modification  

 

Navigation 

 

Admission -> Student Management ->Select institution ->Degree Program-> Batch -> you will find out the list of 

Existing  student list ->in action -> View ->Modify the details ->Save 
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b. Student Disciplinary Actions 

 

Navigation 

 

Admission -> Student Disciplinary Actions ->Select institution -> Program->  you will find out the list of Existing  

student list -> + Add New -> select batch-> student -> Action type details -> save 
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c. Student Certificate request configuration  

 

Navigation 

 

Admission -> Certificate approval Configuration ->Select institution -> select certificate type -> select approval 

staff details ->saves 
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d. Student complete details  

 

Navigation 

 

Admission -> Student complete detail ->Select institution -> select program -> select batch-> Choose student -> 

now you can view students general information, Admission details, Address details, Certificate details, attendance 

details, CIA/CE mark details, Library book taken details, fees details etc., 
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Aveon Infotech Pvt Ltd 
 

5
2
 

 

 



Aveon Infotech Pvt Ltd 
 

5
3
 

 

e. Student late Register 

 

Navigation 

 

Admission -> Student late Slip ->Search student by Roll number/register number or name -> provide date and 

time-> reason 
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20. Subject Details adding 

 

a. Import Subject Entry.   

b. Import Syllabus Entry.   

c. Import Regulation Entry 

 

Navigation 

 

Academic -> Import Regulation subject ->Select institution -> Regulation -> select the excel file ->click next 
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d. Single Subject Entry 

 

Navigation 

 

Academic -> Add subject ->select department -> provide subject details, unit details, subject staff details ->click 

save 
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e. Subject Approval sending to COE Approval 

 

Navigation 

 

Academic -> Course summary ->academic Year -> provide semester -> department -> programme -> search -> 

go to action on list -> click course details ->verify the subject details -> approve / reject  
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f. Subject Adding from Tutor login 

 

Navigation 

 

Academic -> Course summary ->academic Year -> provide semester -> department -> programme -> search -> 

go to action on list -> click course details ->Add the subject details -> submit the subject for COE Approval  

 

 
g. Open Elective Subject Creation 

 

Navigation 

 

Academic -> Open elective -> Add course -> provide the subject details, staff details-> save 
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h. Choice based Credit system Creation 

 

Navigation 

 

Academic -> CBCS -> Add course -> provide the subject details, staff details-> save 
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i. Open elective subject selection form Student login    

j. Choice based Credit system subject selection from student login 

 

21. Time table Creation  

 

Navigation 

 

Academic -> Time Table -> Select institution -> Academic Year->Semester ->Choose the class -> Config the 

timetable -> Generate the time table 
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22. Subject card / LMS 

 

Navigation 

 

Academic -> Subject card -> you will find out the subject details which you are handling current semester -> go 

to action -> you can do lesson plan, mark student attendance, create assignment and allocation to student, internal 

mark entry, conducting online exam, conducting stay back and special classes, study material upload, conducting 

feedback & OBE mapping  

a. Subject card 
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b. LMS Menu 

 

c. Lesson plan creation  
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d. material upload  
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e. lesson plan approval 

 

f. Student attendance Search   
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g. student Attendance Posting 
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h. student Attendance cancel 

 

i. Assignment Creation   
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j. Stay back and Special Class  Creation   
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k. Internal Creation  

 

 

23. Staff Change 

 

Navigation 

 

Academic -> Staff Change -> Class wise /Staff wise /Exam – Class Arrangement can done  
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24. Student Leave Apply  

 

Navigation 

 

Academic -> student leave -> select institution -> Academic year -> semester -> class -> select leave type -> 

select student -> Apply Leave 
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25. Circular  

 

Navigation 

 

Academic -> Circular -> select institution -> Provide the circular details -> choose the Department -> etc -> save. 

 

a. Create a circular  

 

b. Circular list & upload the files for the circular 
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26. Event 

 

Navigation 

 

Academic -> Event -> select institution -> Provide the event details -> make Class arrangement -> save 

 

a. Event Creation 
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B. Class Arrangement  
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27. Tutor Ward System 

 

Navigation 

 

Academic -> Student Tutor -> Tutor View-> + add Tutor => select department =>  choose staff => provide 

Date=> save 

a. Add  Tutor 

 

b. Add Ward 
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c. Change Tutor or Ward 
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28. OBE (Out Come based Education ) 

 

Navigation 

 

Academic -> Outcome Mapping -> select institution -> Regulation -> Degree Program->  

 

 

 

Navigation 

 

Academic -> Outcome Mapping  -> select institution -> Regulation -> Degree Program-> subject 
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29. Polling 

 

Navigation 

 

Academic -> polling -> Config polling -> Save  
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30. Student Login 

 

a. Complaint Register 

 

b. Profile Edit  

 

c. Poll Voting 

 

d.  View Circular  

 

e. Assignment upload  
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f. View Event 

 

g. View Exam timetable 

 

h. Leave apply  

 

i. Hostel Request application 
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j. Library book taken history 

 

k. Feedback providing 
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l. Fees Details view  

 
 

 

m. Attend online exam 
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Dashboards 

Circular 

 
News and Event 

 
Birthday / Wedding day wishes 

 

 
 

Pending Jobs 
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Admission 

 

 
 

Fees collection 

 
 

Staff details 
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Student details 
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Staff attendance 

 
  

 
Student attendance 

 

 
 

Staff calendar 
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Leave balance 

 


